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ASCENDER - NYR Payroll Process Quick
Checklist

This checklist provides a quick at-a-glance view of the steps listed in the complete ASCENDER -
Next Year Payroll Process guide. You can click the step link to open additional information about the
step (as it is displayed in the complete guide).

The NYR Payroll Process Quick Checklist guides you through the necessary steps to create next
year's payroll. This process includes updating tables and employee information, calculating
salaries, performing edits, and interfacing payroll to Budget. This process occurs in the next year
and does not interfere with the current year processing.

This document assumes you are familiar with the basic features of the ASCENDER Business system
and have reviewed the ASCENDER Business Overview guide.

Created: 02/01/2024
Reviewed: 03/01/2024
Revised: 03/01/2024

Some of the images and/or examples provided in this document are for informational
purposes only and may not completely represent your LEA’s process.

Prerequisites

Prerequisites:

Gather Beneficial Data:

This section is strictly for informational purposes.

Before performing the next year payroll process, review the following tables and gather the data that
will be beneficial while you are updating this information for the new school year.

Proposed/Approved Next Year Salary Schedule

https://help.ascendertx.com/business/doku.php/academy/business_payroll_nextyearpayrollprocess
https://help.ascendertx.com/business/doku.php/academy/business_payroll_nextyearpayrollprocess
https://help.ascendertx.com/business/doku.php/academy/business_overview_guide
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Personnel > Tables > Salaries

Once a salary table is assigned to an employee on the Payroll > Maintenance > Staff Job/Pay Data >
Job Info tab, the table can be updated and salary calculations can be run for all affected employees
eliminating the need to update the information for each individual employee.

Proposed/Approved Next Year Workday Calendars

Personnel > Tables > Workday Calendars > School Calendar

After receiving the upcoming approved school year calendars, you can create a calendar(s) to assist
with documenting employee workdays and holidays. It is helpful to plan future pay dates and payoff
dates for the next school year in advance.

Reference State Minimum Salary Schedule

Review the TEA Minimum Salary Schedules for changes effective with the new school year.

Accrual Calendar Information

Payroll > Tables > Accrual Calendars > Accrual Calendar

❏ Creating and assigning an accrual calendar to employees allows you to maintain the accrual
calculations throughout the school year. You can obtain workdays by month information from the
workday calendars.

❏ Be sure to keep the same accrual codes for each accrual calendar. This method allows for
consistency and eliminates the need to update the information for each individual employee.

❏ Accounting for the August EOY accrued days in the accrual calendar and using the EOY Payroll
Accruals process assists in properly accounting for accruals across the fiscal years.

Update Next Year Staffing Changes

When payroll opens for the next year, be sure to keep up with the following staffing updates:

https://help.ascendertx.com/business/doku.php/payroll/maintenance/staffjobpaydata/jobinfo
https://help.ascendertx.com/business/doku.php/payroll/maintenance/staffjobpaydata/jobinfo
https://help.ascendertx.com/business/doku.php/personnel/tables/workdaycalendars/schoolcalendar
https://tea.texas.gov/Texas_Educators/Salary_and_Service_Record/Minimum_Salary_Schedules/
https://help.ascendertx.com/business/doku.php/payroll/tables/accrualcalendars/accrualcalendar
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Resignations and new hires: Update the employee status as resignations and new hires are
approved to allow the appropriate budget amounts to be created and interfaced.
Campus level changes: Update the job table and employment information as jobs move from
one campus to another.
Distribution changes: Update employee distributions based on budget changes.
Update extra duty/stipend pay: Update the extra duty table to reflect changes and
payments. Also, update the balance on the Payroll > Maintenance > Staff Job/Pay Data > Pay
Info tab. The next year payroll budget calculations use the s-type extra duty remaining amount;
therefore, it is important to verify that these amounts have been updated.
Update substitute pay: If substitute pay rates change, update the Personnel > Tables >
Salaries > Substitute tab, which is associated with entering employee substitute leave
transmittals.

Extract Third Party Administrator (benefits) Information

Payroll > Utilities > Employee Benefits Interface > Extract

Perform an extract to create the files containing deductions and demographic data to be sent to the
third-party vendor.

Only deduction codes that have an Extract Ded Cd (extract deduction code) on the Payroll > Tables
> Tax/Deduction > Deduction Code are extracted.

After the new premiums are updated by the third-party administrator and the file is returned, you can
import the updated file making the changes to the next year deductions in one step.

Payroll > Utilities > Employee Benefits Interface > Import Annual File

This utility imports the next year employee benefit choices via a file created by your third-party
vendor. Importing data decreases the amount of time it takes to enter individual employee data
changes.

Manage Employee Change Requests

❏ Create a form for next year employee change requests. This form assists with data entry and
provides documentation.

❏ Set a deadline for employee change requests prior to the end of the current school year to allow
time for clarification if needed.

❏ Update employee direct deposit information. Use caution when updating this information in the
next year frequency as the system will prompt you to update this information in the current year
frequency.

https://help.ascendertx.com/business/doku.php/payroll/maintenance/staffjobpaydata/payinfo
https://help.ascendertx.com/business/doku.php/payroll/maintenance/staffjobpaydata/payinfo
https://help.ascendertx.com/business/doku.php/personnel/tables/salaries/substitute
https://help.ascendertx.com/business/doku.php/personnel/tables/salaries/substitute
https://help.ascendertx.com/business/doku.php/payroll/utilities/employeebenefitsinterface/extract
https://help.ascendertx.com/business/doku.php/payroll/tables/taxdeductions/deductioncd
https://help.ascendertx.com/business/doku.php/payroll/tables/taxdeductions/deductioncd
https://help.ascendertx.com/business/doku.php/payroll/utilities/employeebenefitsinterface/import
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❏ If your LEA has not already done so, set up the EmployeePortal application. EmployeePortal allows
employees to submit demographic changes and payroll (W-4 and direct deposit) changes. LEA-defined
options determine what changes can be made by the employee and the necessary approvals.

Before You Begin

Before you begin:

Things to Remember Prior to Beginning NYR Payroll

❏ Ensure open communication exists between the payroll office and business office.

Verify that the Budget process is complete and the budget is open.
Set potential deadlines for various presentations.

❏ Verify that you are logged on to the current pay frequency.

❏ Remember: Next year calculations and distributions are validated to the new budget (N). Make
sure that the fiscal year on the distribution pages matches what is in the new budget (N). If it changes
during the process, perform a mass update.

Current and Next Year Shared Pages

The following pages are shared between the current year and next year. Use Caution
when updating these pages in the next year:

Personnel or Payroll > Tables > District HR Options
Personnel > Tables > Credential
Payroll > Tables > Tax/Deductions
Payroll > Tables > Bank Codes
Personnel > Maintenance > Staff Demo (all tabs)
Personnel > Maintenance > Employment Info

Reminders

New employees must have a Unique ID. Create a Personnel record and copy it to NY Payroll to
ensure that they are included in the Unique ID Extract.
Do not update years of service or leave until Service Records have been created. This usually
occurs between the June and July payrolls and is covered in the Service Record guide.
Medicare On-Behalf is usually posted to the TRS website in late summer. In most cases, a
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reminder is sent by your ESC so you can book actuals to Finance for the year and create a
budget for next year.
Remember to update NY Payroll in Budget periodically to ensure that changes are updated. This
allows Budget to remain as current as possible.

Extract IDs

Extract IDs can be used to group similar employees to allow for easier and more accurate mass
updates. For example, most 187-day teachers/aides have the same contract Begin and End Dates,
same Calendar Code, and the same Payoff Date, which may allow them to be grouped together by
extract ID making it easier to select that group of employees when performing Mass Updates.

To use extract IDs:

Personnel > Tables > Job/Contract > Extract ID

❏ Add or modify extract IDs.

These extract IDs must meet your LEA's criteria so it is important for the Payroll and
Personnel departments to communicate about the setup and use of extract IDs.

Personnel > Maintenance > Employment Info

https://help.ascendertx.com/business/doku.php/personnel/tables/jobcontract/extractid
https://help.ascendertx.com/business/lib/exe/detail.php/general/quickview/nextyearpayroll/nyr_extract_id_tab.jpg?id=academy%3Aquickchecklist_nextyearpayrollprocess
https://help.ascendertx.com/business/doku.php/personnel/tables/jobcontract/extractid
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❏ After extract IDs are established, assign or modify the extract IDs for each individual employee
record.

Payroll > Utilities > Mass Update

❏ After extract IDs are assigned as needed, select the applicable Extract ID and run the necessary
mass update for a specified group of employees. Extract IDs can also assist in sorting and filtering
report data.

Personnel > Reports > User Created Reports

If your LEA uses extract IDs to group employees for mass updates, generate a user-created report to
verify that extract IDs are correctly assigned to employees.

https://help.ascendertx.com/business/lib/exe/detail.php/general/quickview/nextyearpayroll/nyr_payroll_employment_info_page.jpg?id=academy%3Aquickchecklist_nextyearpayrollprocess
https://help.ascendertx.com/business/doku.php/payroll/utilities/massupdate/employee
https://help.ascendertx.com/business/lib/exe/detail.php/general/quickview/nextyearpayroll/nyr_payroll_mass_update_extract_id.jpg?id=academy%3Aquickchecklist_nextyearpayrollprocess
https://help.ascendertx.com/business/doku.php/personnel/reports/usercreatedreports/hrreport
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If extract IDs are missing or need to be changed, you can manually update individual employee
records using the Personnel > Maintenance > Employment Info page.

NYR Payroll Process Quick Checklist
Task Reference

the Step in
NYR Payroll
Process
Guide

Update Payroll Current Pay Frequency

❏
Finance > Inquiry > General Ledger Inquiry > General Ledger Inquiry

Verify August EOY payroll accruals.
Step 1

❏
Payroll > Next Year > Copy CYR Tables to NYR > Clear Next Year Tables

Clear all next year (NYR) tables.
Step 2

❏
Payroll > Next Year > Copy CYR Tables to NYR > Copy Current Year Tables

Copy all current year (CYR) tables to next year (NYR).
Step 3

❏

Payroll > Next Year > Copy CYR Staff to NYR
Copy the employees from the current year payroll to the next year payroll. If you
have multiple pay frequencies, complete this task in all pay frequencies.
• Under Pay Status, select Active to copy only active employees.
• In the Pay Type field, select E Exclude Substitute.
• Under Options, it is recommended to select Include Employees with
Termination Date to copy active employees with a termination date on the
Personnel > Maintenance > Employment Info tab.

❏ Click Execute to begin the process of copying the employees.

Step 4

❏ Verify employee data using various reports. Step 5

Update Personnel

❏

Personnel > Tables > Credential

Update Credential tabs as needed.

Note: The Teaching Specialization tab is used to report Pre-K teachers for Class
Roster so if there have been changes, you can make those updates now in
anticipation of the submission.

Step 6

https://help.ascendertx.com/business/doku.php/personnel/maintenance/employmentinfo
https://help.ascendertx.com/business/doku.php/finance/inquiry/generalledgerinquiry/generalledgerinquiry
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step1
https://help.ascendertx.com/business/doku.php/payroll/nextyear/copycyrtablestonyr/clearnextyeartables
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step1b
https://help.ascendertx.com/business/doku.php/payroll/nextyear/copycyrtablestonyr/copycurrentyeartables
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step2
https://help.ascendertx.com/business/doku.php/payroll/nextyear/copycyrstafftonyr
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step3
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step4
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step12
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Task Reference
the Step in
NYR Payroll
Process
Guide

❏

Personnel > Tables > Salaries NYR

Update the next year salary tables to reflect any changes to the salary schedules
(anticipated or known).
• Local Annual - This tab is the most commonly used. You can make mass
updates by percent or dollar amount, or by employee. To see a change before
saving the record, enter the change and click Default. The original annual amount
is displayed in the Annual Amt column, the percent or dollar is increased, and the
New Amount is displayed. Click Save. If decreasing a salary, enter a negative
percent or dollar amount.
• Hourly/Daily and Midpoint - These tabs can be updated in the same way if
used by your LEA.
• Substitute - This tab can be manually updated as needed.
• State Min - This tab is updated via a file upload when applicable. These
instructions are sent separately with the file as needed.

Step 7

❏

Personnel > Tables > Job/Contract > Job Codes NYR

Add or update job codes as needed.

Note: You can assign accrual codes, Workers’ Comp codes, and FTE hours to
lessen the workload when completing tabs for new employees.

Step 8

❏

Personnel > Tables > Workday Calendars

Create calendars.
• Calendars tied to a numeric frequency (e.g., 6) are used for current year.
• Calendars tied to an alpha frequency (e.g., F) are used for next year. Use the
spyglass to create or edit calendars as needed.
• You can copy calendars that begin in the same month. Example: If you create
the 10-month calendar beginning in August for teachers for 187 days, you can
copy the calendar to the Food Service and Bus Driving calendar codes, and then
edit them to reflect the differences such as begin dates and holidays.

Step 9

❏
Personnel > Maintenance > Staff Demo > Demographic

Update staff demographic data.
Step 10

❏

Personnel > Maintenance > Employment Info

Review retirees and verify that NY Take Retiree Surcharge is selected in order
to include the retiree surcharge when the Extract Payroll to Budget process is
performed.

Review and update terminated employees. It is best practice to not only update
the Termination Date and Reason but, if applicable, update the Auxiliary Role
ID and Paraprofessional Certification End Date. Also, update the End Date on
the employee's responsibility record.

Step 11

Update Payroll Next Year Pay Frequency

https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step6
https://help.ascendertx.com/business/doku.php/personnel/tables/jobcontract/jobcodes
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step9
https://help.ascendertx.com/business/doku.php/personnel/tables/workdaycalendars/schoolcalendar
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step5
https://help.ascendertx.com/business/doku.php/personnel/maintenance/staffdemo/demographicinformation
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step13
https://help.ascendertx.com/business/doku.php/personnel/maintenance/employmentinfo
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/employmentinfo
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Task Reference
the Step in
NYR Payroll
Process
Guide

❏

Payroll > Tables > Tax/Deductions
Update the following tabs as needed.
• FICA Tax - This tab is used to copy rates from the current calendar year to next
calendar year.
• Unemployment - This tab can be updated as applicable to your LEA. Some
LEA's budget by selecting Taxable while others may select Reimbursable and
manually add an amount in Budget. Verify how your LEA is handling
unemployment in the current year to determine if you want to continue. You can
contact your regional ESC consultant if you need additional assistance but set the
next calendar year as desired so calculations will be accurate for the entire year.
DO NOT change the current calendar year as that is being used in the current year
payroll.
• TRS Rates - This tab should have been updated previously. Review for accuracy.
• Workers' Compensation - This tab can be updated as rates change. Be sure to
verify the accuracy of the rates as some carriers send the rates as decimals and
others send as a percentage; therefore, you will need to add the decimal.
• Deduction Codes - This tab can be updated as you receive updated information
from your TPA or make changes to deductions that are offered. The majority of
LEAs import deduction changes for each employee using a file from your TPA.
Reviews the table for any necessary changes.

Step 12

❏

Payroll > Tables > Accrual Calendars > Accrual Calendar

Create accrual calendars as needed. Review codes in the current pay frequency to
ensure you are duplicating dates and days to the correct group.
• Most districts only accrue 10 employees. If that is true for you, each code should
begin with August 31 and show the number of days that group of employees will
work in August. Add 12 more lines and enter the true/regular Pay Dates. Enter the
days employees work in the month associated with each pay date.
• Typically, July and August (and sometimes June) will show the pay date and zero
days, but they still must be included.
• Dates used (with the exception of August 31) must match the Pay Dates that will
be built in the Pay Date Table.

Step 13

❏
Payroll > Utilities > Mass Update > Deductions

If applicable, mass update the Employer Contribution and Remaining
Payments for all employees with health care and other employer paid deductions.

Step 14

❏

Payroll > Utilities > Mass Update > Employee

Mass update the Pay Step and State Step fields for all employees tied to a salary
table. This allows preliminary payroll data to be sent to Budget as a starting point.
Consider repeating this step as follows for each pay type to ensure that all
employees are incremented properly.
• For Pay Type 1 (Contracted Employees), increment once for both the Pay Step
and State Step.
• For Pay Type 2 (Non-contracted Employees), only increment the Pay Step for
these employees as they are not subject to Stat Min making the State Step
unnecessary.
• If needed, repeat for Pay Type 3 (Hourly Employees).

Step 15

https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step7
https://help.ascendertx.com/business/doku.php/payroll/tables/accrualcalendars/accrualcalendar
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/stepupdateaccrualcalendars
https://help.ascendertx.com/business/doku.php/payroll/utilities/massupdate/deductions
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/massupdatedeductions
https://help.ascendertx.com/business/doku.php/payroll/utilities/massupdate/employee
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/massupdateemployee
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Task Reference
the Step in
NYR Payroll
Process
Guide

❏

Payroll > Utilities > Mass Update > Employee

Mass update data as needed. The following fields are commonly updated.
• Fiscal Year - If some employees should not be incremented to the next fiscal
year, repeat this step only selecting specific employees and mass update them
back to the correct fiscal year. An example of this may include those paid with
Elementary and Secondary School Emergency Relief (ESSER) Programs.
• Contract Begin Date
• Contract End Date
• Nbr Days Empld
• # of Months in Contract
• Payoff Date
• (Number of) Annual Payments
• (Number of) Remaining Payments
• (Number of) WC Annual Payments
• (Number of) WC Remaining Payments

Step 16

❏

Payroll > Utilities > Mass Update > Extra Duty

Mass update the remaining payments on all extra duties for applicable employees.
Complete the Remain Pymts field under Change Existing Extra Duty Code
Information.

Step 17

❏

Payroll > Utilities > Mass Update > Salary Calculations

Perform salary calculations for employees. An error report will provide a list of
employees not tied to a salary table. Use this list as a reminder of which
employees need to be manually updated.

Step 18

❏

Payroll > Maintenance > Staff Job/Pay Data > Job Info and Distributions
Manually add or update salary information for those employees not tied to salary
tables. For example, most often, administrators such as the Superintendent or
Principal.
• Manually enter an estimated annual salary amount for pay type 3 (Hourly)
employees in order to budget for these employees.
• Add new employees as information becomes available.

Step 19

Verify Accuracy of Data
❏ Verify TRS fields. Step 20
❏ Verify salary calculations. Step 21

❏
Payroll > Utilities > Payroll Simulation > Addendum

Verify data using addendum sheets.
Step 22

❏
Payroll > Utilities > Pre-Edit Payroll Data

Perform “test payroll”.
Step 23

❏
Payroll > Utilities > Employee Benefits Interface > Import Annual File

Perform staff benefits updates.
Step 24

https://help.ascendertx.com/business/doku.php/payroll/utilities/massupdate/employee
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/massupdateemployee2
https://help.ascendertx.com/business/doku.php/payroll/utilities/massupdate/extraduty
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/massupdateextraduty
https://help.ascendertx.com/business/doku.php/payroll/utilities/massupdate/salarycalculation
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step17
https://help.ascendertx.com/business/doku.php/payroll/maintenance/staffjobpaydata/jobinfo
https://help.ascendertx.com/business/doku.php/payroll/maintenance/staffjobpaydata/distributions
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step19b
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step11a
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step18
https://help.ascendertx.com/business/doku.php/payroll/utilities/payrollsimulation/addendum
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step19
https://help.ascendertx.com/business/doku.php/payroll/utilities/preeditpayrolldata
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step20
https://help.ascendertx.com/business/doku.php/payroll/utilities/employeebenefitsinterface/import
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step15
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Task Reference
the Step in
NYR Payroll
Process
Guide

Interface NY Payroll to Budget - These steps can be repeated as often as
necessary to update budget data.

❏

Payroll > Next Year > Interface NY Payroll to NY Budget > Extract Payroll Account
Codes

Work across the tabs to extract next year payroll data. Review the reports and
interface to Budget to provide preliminary budget amounts if needed.

Step 25

❏
Payroll > Next Year > Interface NY Payroll to NY Budget > Extract Reports

Verify the Extract Reports tab.
Step 26

❏ (If necessary) Perform another extract and interface to Budget. Step 27

❏
Payroll > Next Year > Interface NY Payroll to NY Budget > Interface to Budget

Interface to Budget.
Step 28

https://help.ascendertx.com/business/doku.php/payroll/nextyear/interfacenypayrolltonybudget/extractpayrollaccountcodes
https://help.ascendertx.com/business/doku.php/payroll/nextyear/interfacenypayrolltonybudget/extractpayrollaccountcodes
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step21
https://help.ascendertx.com/business/doku.php/payroll/nextyear/interfacenypayrolltonybudget/extractreports
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step22
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step23
https://help.ascendertx.com/business/doku.php/payroll/nextyear/interfacenypayrolltonybudget/interfacetobudget
https://help.ascendertx.com/business/doku.php/general/quickview/nextyearpayroll/step24
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